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OSTEO: NEW FEATURES AND ENHANCEMENTS
The following are new features and enhancements in BIOQUANT OSTEO 2017, v17.2.6.

TOPIC CONTENTS

Protocol and Template Changes 3

Tutorial Data Set Enhancements 5

New Video Tutorial Help 10

New Mesaurement Type: Referent Data 10

Large Image Navigator Enhancements 12

Color, Psuedocolor, & Customizing Enhancements 19

Threshold Region Enhancements 25

Minor Enhancements 27

PROTOCOL AND TEMPLATE CHANGES
The following changes have been made to the BIOQUANT  Templates and Protocols.

TOPIC CONTENTS

Template Sets: Support for Referent Data Type 3

Template Sets: Renamed 4

Template Sets: Support for Referent Data Type
The following Template Data Sets have been updated to support the new Referent Data Measurement 
Type. The Referent Data Measurement Type replaces the methodology that used Automatic Bone 
Perimeter and array comments to simultaneously measure Tissue Volume, Bone Volume, and Bone 
Surface. See “New Mesaurement Type: Referent Data on page 10.”

IMPORTANT: READ UPDATED PROTOCOLS

• It is important if you use one of these data sets as a template that you read the 
updated protocol for measuring with the Referent Data Measurement Type.  

• This protocol is more transparent and easier to use than the previous method.

IMPORTANT: TRANSISTION FOR TEMPLATES BASED ON OLDER VERSIONS 

• Good News! If you have a custom template from a previous version of BIOQUANT 
OSTEO, when you select an array with the Automatic Bone Perimeter comment, 
BIOQUANT OSTEO automatially switches to the Referent Data Measurement Type 
and correctly fill the TV, BV, and BS drop lists. You don’t have to do anything.

• However, the Automatic Bone Perimeter comments used in previous versions of 
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BIOQUANT OSTEO are no longer supported by the General Measurement Type. If 
you manually switch back to the General Type and use a Bone Surface or Perimter 
array with the ABP; comment, it will be ignored. The measurement generated 
will be a “normal” surface measurement and will include surface that touches the 
region of interest and will not include void surface. 

TEMPLATE SETS: ARRAYS THAT NOW USE REFERENT DATA TYPE

• Basic Bone Template 

L1 Bone Surface now uses Referent Data Type.

• Bone Arthritis Template

L1 Epiphysial Bone Surface now uses Referent Data Type.

L2 Trabecular Bone Surface now uses Referent Data Type.

• Bone Metastasis Template

L1 Bone Surface now uses Referent Data Type.

• microCT Template

L1 Bone Surface now uses Referent Data Type.

• Tb.Human - Tri TBlue Fl

L9 (BS) Bone Surface now uses Referent Data Type.

• Tb.Rodent - Tri TRAP Fl

L3 Bone Surface now uses Referent Data Type.

• Tb.Rodent - VK TBlue TRAP Fl

L3 Bone Surface now uses Referent Data Type.

• Tb.Rodent - Single Slide

L3 Bone Surface now uses Referent Data Type.

• Tb.Human - Single Slide

L9 (BS) Bone Surface now uses Referent Data Type.

• Osseointegration Template

L1 Implant Perimeter now uses Referent Data Type.

L3 Contact Perimeter now uses Referent Data Type.

Template Sets: Renamed
The “Sacropenia Template” has been renamed “Muscle Phenotyping” to better reflect the range of 
applications that it can support.
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TUTORIAL DATA SET ENHANCEMENTS
The following enhancements have been made to the Help System and Tutorial Data Sets.

TOPIC CONTENTS

Sample datasets are now Tutorial Sets 5

Welcome Screen: New “Open a Tutorial Data Set” button 6

New: Open Tutorial Set box 9

Sample datasets are now Tutorial Sets
In BIOQUANT OSTEO 2017, the Sample Datasets have been replaced with Tutorial Sets that are 
opened directly using the Open a Tutorial Set box. 

In the previous version of BIOQUANT OSTEO we included Sample Datasets that installed into a 
BQDATA\BQ2016 folder. The user could open these Sample Datasets and follow their guides to learn 
how to use BIOQUANT.

All BIOQUANT OSTEO 2017 Tutorial Sets have been updated to use the new Referent Data 
Measurement Type, if applicable.

OSTEO 2017 TUTORIAL SETS

• Getting Started Set

• Bone Arthritis

• Bone Metastasis

• Bone Stereology

• Chondrocyte Proliferation

• microCT

• Muscle Phenotyping

• Osseointegration

• Trabecular Human - Tri TBlue Fl (Trichrome, Toluidine Blue, Fluorescence Set)

• Trabecular Rodent - Fl Slide Only (Fluorescent Slide Only)

• Trabecular Rodent - Tr TRAP Fl Set (Trichrome, TRAP, Fluorescence Set)

• Trabecular Rodent - VK TBl TRAP Fl Set (Von Kossa, Toluidine Blue, TRAP, 
Fluorescence Set)

• No Guide - Cortical Basic

• No Guide - Cortical Complete
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THE OPEN A TUTORIAL SET BOX CAN BE OPENED IN TWO WAYS 

1. From the “Welcome” splash screen, click the “Open a Tutorial Data Set” button

For more information, see “Welcome Screen: New “Open a Tutorial Data Set” button on page 
6.”

2. From the File menu, choose “Open a Tutorial Set.” 

For more information, see “New: Open Tutorial Set box on page 9.”

Welcome Screen: New “Open a Tutorial Data Set” button
On the Welcome splash screen that comes up when you open BIOQUANT OSTEO, a new “Open a 
Tutorial Data Set” button has been added.

This button opens the Open Tutorial Set box, which lists all the Tutorial Data Sets included with 
BIOQUAN OSTEO. Once a Tutorial Data Set is selected, you can follow its Guide to learn the protocol. 
The Tutorial Data Sets use Sample Images that were installed when you installed BIOQUANT OSTEO 
2017. 

Following the guides for the Tutorial Data Set that closest matches your protocol trains you on how 
to use new features and enhancements in the software.

For example, all user who do rodent trabecular measurements should open the “Tb.Rodent - Tri TRAP 
Fl Set” tutorial set and follow its guides to learn how to use the new Referent Data Measurement 
Type feature.

PROCEDURE

Pointer: A good place to start if you have never used BIOQUANT is with the Getting Started Set.

1. From the BIOQUANT Splash Screen that comes up when you open BIOQUANT OSTEO, choose 
the Open a Tutorial Data Set option.

Alternatively, if BIOQUANT OSTEO is already open, from the File menu, choose Open a Tutorial 
Set.
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BIOQUANT WELCOME SCREEN

Chose the “Open a Tutorial Set” option.

2. On the Open a Tutorial Set box, from the “Select a Tutorial Set” region, click to highlight the 
tutorial set, then click the Open button.

Alternatively, you can double click the tutorial set to open it.

If this is the first time you have used BIOQUANT, choose the Getting Started Set.
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OPEN A TUTORIAL SET BOX

Choose the “Getting Started Set” if this is the first time you have used BIOQUANT.

3. A “Tutorial Set” message opens that says: “To continue, follow the directions in the Guide 
region at the left end of the tool ribbon.” Click the OK button.

BIOQUANT WELCOME SCREEN

Click OK and then continue by reading the Guide region.

4. BIOQUANT OSTEO opens the tutorial set and loads parameters associated with it. To find out 
what to do next Start following the directions in the Guide region in the upper left corner of the 
ribbon. 

If you opened the Getting Started Set, the “Welcome” guide in the Guide region of the ribbon 
tells you different ways of getting written and video help. It then refers you to the “Introduction 
to BIOQUANT OSTEO guide that walks you through the interface. 

To see more guides that walk you through sample protocols using sample images, in the guide 
region, from the Open drop list, click on one of the pre-defined guides.
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New: Open Tutorial Set box
If BIOUANT is already open, from the File menu, choose Open Tutorial Set to open the “Open a 
Tutorial Set” box. 

PROCEDURE

1. If BIOQUANT OSTEO is already open, from the File menu, choose Open Tutorial Set.

2. On the Open a Tutorial Set box, from the “Select a Tutorial Set” region, click to highlight the 
tutorial set, then click the Open button.

Alternatively, you can double click the tutorial set to open it.

If this is the first time you have used BIOQUANT, choose the Getting Started Set.

OPEN A TUTORIAL SET BOX

Choose the “Getting Started Set” if this is the first time you have used BIOQUANT.

3. A “Tutorial Set” message opens that says: “To continue, follow the directions in the Guide 
region at the left end of the tool ribbon.” Click the OK button.
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BIOQUANT WELCOME SCREEN

Click OK and then continue by reading the Guide region.

4. BIOQUANT OSTEO opens the tutorial set and loads parameters associated with it. To find out 
what to do next Start following the directions in the Guide region in the upper left corner of the 
ribbon. 

If you opened the Getting Started Set, the “Welcome” guide in the Guide region of the ribbon 
tells you different ways of getting written and video help. It then refers you to the “Introduction 
to BIOQUANT OSTEO guide that walks you through the interface. 

To see more guides that walk you through sample protocols using sample images, in the guide 
region, from the Open drop list, click on one of the pre-defined guides.

NEW VIDEO TUTORIAL HELP
BIOQUANT OSTEO 2017 still has integrated video within the BIOQUANT OSTEO 2017 Manual. These 
videos have also been pulled out into a second manual that consists only of videos. There are several 
ways to quickly open video help.

ON THE TOOL RIBBON, CLICK THE VIDEO TUTORIAL HELP BUTTON

Each region of the Ribbon has a new  video tutorial buttons. Clicking this button opens the video 
help PDF to the relevant page.

FROM THE HELP MENU, CHOOSE TUTORIAL VIDEOS

On the Help menu, the “Tutorial Videos...” has been added. This opens the front page of the Tutorial 
Videos manual.

ON THE DESKTOP, DOUBLE CLICK THE OSTEO VIDEO TUTORIALS MANUAL

This opens the Tutorial Videos manual in the PDF reader.

NEW MESAUREMENT TYPE: REFERENT DATA
There is a new Measurement Type called the “Referent Data” Measurement Type. It is used to 
simulatenosly measure Tissue Volume, Bone Volume, and Bone Surface. It replaces the “Bone 
Referent Array Set” used in previous versions.
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CHOOSE THE REFERENT DATA TYPE & CONFIRM TV, BV, BS ARRAYS

The Referent Data Measureent Type is listed as one of the options in the Type drop list on the 
Measurement region of the ribbon.

REFERENT DATA HAS DROP LISTS FOR THE FOLLOWING ARRAYS:

• TV drop list: Contains the Tissue Volume array.

The TV Array measures the area of all pixels inside and touching the region of interest, 
whether or not they are thresholded. 

• Bone Volume drop list: Contains the Bone Volume array.

The BV Array measures the area of all thresholded pixels inside and touching the preview 
tracings, except for valid void space. Thresholded pixels that are not outlined by the 
preview tracing are not measured.

When the Preview tracing is generated, small holes in the bone are automatically filled 
with threshold and included in the Bone Volume measurement. 

When the Preview tracing is generated, valid void space is preview outlined and not 
included in the Bone Volume. 

The Void Filter is used to determine the size of holes that are valid void space or 
automatically filled as bone.

• Bone Surface drop list: Contains the Bone Surface array.

The BS Array records the perimeter of preview outlined objects, excluding the portion of 
the preview outline that touches the region of interest.

When Preview outlines are generated, valid void spaces are preview outlined, according to 
the Void Filter, and are included in the Bone Surface measurement. 

Invalid Surfaces created by the preview outline touching the region of interest (i.e. Tissue 
Volume), are not included in the Bone Surface measurement. 

If you are using an OSTEO 2017 Template or Tutorial Data Set:

• When you select an array that supports the Referent Data Type, the system automatically 
changes the measurement type and automatically chooses the proper arrays from the 
Tissue Volume, Bone Volume, and Bone Surface drop lists.

If you are using a template based on a previous version of BIOQUANT OSTEO:

• When you select a Bone Surface array that has the Automatic Bone Perimter (ABP) 
comment, the system automatically switches you to the Referent Data Measurement Type 
and correctly fills the TV, BV, and BS drop lists for you. 

See “Protocol and Template Changes on page 3.”

If you have created your own template from scratch in BIOQUANT OSTEO 2017:

• In the Selected List region, in the Selected box, click to highlight the array that will be 
used as the Bone Surface array.
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• In the Measurement region, from the Type List, choose Referent Data.

• Then, choose the correct TV, BV, and BS arrays from the drop lists. 

• Finally, click Assign next to the Type drop list so that the Referent Data Type and TV, BV, 
BS arrays are assigned to the current Seleced array.

SAMPLE PROCEDURE

This is a brief procedure for the use of the Referent Data Measurement Type.

1. Load a scan of the section.

2. Use the Large Image Navigator to zoom out so the Tissue Volume is visible in one field of view

3. Use the ROI Tools region to define the Tissue Volume.

iROI Cursor Type: Creates an irregular ROI 

TV ROI Type: Creates a rectangular ROI 

4. Use the Threshold region to threshold the bone.

Click Select, click on the bone, scroll the mouse wheel up, right click to exit.

5. Use the Editing region make improvements to the threshold.

Draw, Erase, Clean, Dilate, and Erode are commonly used. This also generates a Preview 
outline.

6. Once the Preview tracing is correct, click the Measure button.

The Tissue Volume, Bone Volume, and Bone Surface are automacally measured. The Overview 
window updates. The Calculate box updates. If a mistake was made, click the Undo button in the 
Measurement region.

For a completed and more detailed procedure, see the protocol that best matches your template in 
the BIOQUANT OSTEO Manual.  

LARGE IMAGE NAVIGATOR ENHANCEMENTS
The Large Image Navigator has the following Enhancements.

TOPIC CONTENTS

Crop Image 13

Pan Box Snaps to ROI 16

Measure Cells: Separate Coarse Move Size 18
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Crop Image
The Large Image Navigator has a new feature that lets you crop a Scan to the region you are actually 
interested in measuring. This is also useful becuse the Shrink To Fit zoom level will now be able to 
show the measurement region at a higher resolution since there will be less extra tissue to fit in the 
Image window.

You can crop a BIF, BMP, or TIF image. The system will crop the image to the same file type that it 
was before the crop, i.e., BIF to BIF, BMP to BMP, and TIF to TIF.

PROCEDURE

1. Open a large BIF, BMP, or TIF scan into the Large Image Navigator.

See “Open Single Image.”

2. On the Large Image Navigator, click the  Shrink/Expand Image to fit the entire view in the 
Image window.

CROP IMAGE EXAMPLE

Shrink the image to fit the Image window.

3. On the Large Image Navigator, click the  Crop Image button.

The cursor enters the Image window.
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4. In the Image window, click and drag over the region you want cropped to create a rectangle.

You can repeat making the rectangle shape until it matches your requirements.

CROP IMAGE EXAMPLE

The crop area has been defined.

5. Right click to exit the Image window.

The BQ Save Cropped Image window opens. Note that BQ Save Cropped Image will only save to 
the same file format as the original image.
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CROP IMAGE EXAMPLE

Enter a new name for the cropped image.

6. On BQ Save Cropped Image, type a name for the cropped file and then click the Save button.

The cropped image opens. If it is larger than 1280 x 960, it opens into the Large Image 
Navigator.
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CROP IMAGE EXAMPLE

The new image opens in the Image window.

Pan Box Snaps to ROI
The Large Image Navigator now shows the current Tissue Volume/Sampling Area ROI tracing. 

If the Pan box is moved outside the Tissue Volume/Sampling Area ROI tracing, it now snaps to the 
closest ROI tracing border. 

This prevents you from measuring a field outside of the Tissue Volume/Sampling Aea ROI tracing.

It also allows the Coarse Move Pan Box button to sequence field to field withouth leaving the Tissuve 
Volume/Sampling Area. When the Pan box reaches the ROI tracing edge, it loops back around to the 
next row of the ROI tracing. 
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LARGE IMAGE NAVIGATOR

The blue Pan box is always inside or touching the green ROI.

WHAT IS AUTO ROI?

When measuring within a Tissue Volume or Sampling Area at high mag, Auto ROI is the feature 
that generates the region of interest (ROI) for you whenever you move the Pan box in the Large 
Image Navigator. 

• If you move the Pan box completely within the Tissue Volume/Sampling Area tracing, 
the system changes to a Full Screen ROI. 

• If you move the Pan box so that it overlaps the Tissue Volume/Sampling Area tracing, the 
system changes to the Topo ROI and uses the Sampling area redraw visible in the Image 
window as the ROI.

• Now, if you move the Pan box completely outside of the Tissue Volume/Sampling Area, 
the system will snap the Pan box back to a field that contains Sampling Area tracing.

• To provide user feedback, the Tissue Volume/Sampling Area tracing now redraws within 
the Large Image Navigator.
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WHAT’S COOL ABOUT THE COARSE MOVE PAN BOX BUTTON?

You can use the  Coarse Move Pan Box button to automatically navigate through the 
Sampling Area and the Pan Box stays on fields touching or within the Sampling Area. Once 
you’re done measuring a field of view, just click the  Coarse Move Pan Box button. It will find 
the next consecutive field of view automatically, even if that’s the next row down.

In cases where you have easily thresholded cells that don’t require user interactive threshold 
editing, this means that you could use Batch Scripts to do the navigation, automatic threshold 
commands (such as Clean, Erode, Dilate), and measurement for you. See Batch Scripts in the 
OSTEO Manual.

Measure Cells: Separate Coarse Move Size
The Large Image Navigator Coarse Move buttons now have a step size setting exclusively for Measure 
Cells. This is important because the Measure Cells type requires an overlap between adjacent fields of 
view but other measurement types require no overlap between adjacent fields of view.

Now there’s no need to keep adjusting the overlap for the Coarse Move buttons. 

COARSE MOVE BUTTONS

When using Measure Cells, you can now set a different 
image overlap with the Coarse Move buttons.

TO CHANGE THE COARSE MOVE STEP SIZE

1. Open an image with a resolution larger than 1280 x 960 to open the Large Image Navigator.

2. On the Large Image Navigator box, click the  Navigator Setup button to open the Navigator 
Setup box.

3. On the Navigator Setup Box, change the Coarse Move Step (Measure Cells).

For many cell populations, the default 90% should work.

If you have larger cells, you might need to decrease the step size so that large cells won’t be 
split across the border of the image.
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NAVIGATOR SETUP BOX

The default Coarse Move Step for Measure Cells is 90.

DEFAULT VALUES

• Coarse Move Step (Measure Cells): 90 
This sets the Coarse Move button setup size for the Measure Cells Measurement 
Type only.

• Coarse Move Step (% of Pan Box): 50 
This sets the Coarse Move button setup size for all Measurement Types besides 
Measure Cells.

4. When you are finished, click the OK button to close the Navigator Setup box. 

Now whenever you click on of the Coarse Move buttons, and you are using the Measure Cells 
Measurement Type, the field will move the indicated amount.

COLOR, PSUEDOCOLOR, & CUSTOMIZING ENHANCEMENTS
The following changes have been made to the Color palette, Pseudocolor box, and Customizing box.

TOPIC CONTENTS

Color Palette Changes 19

Customizing Box Changes 20

Pseudocolor Changes 22

Color Palette Changes
The Color palette has changed to offer brighter colors. The color palette is used in several places in 
BIOQUANT, including:

• The measurment Color drop-list in the Parameters region.

• The Threshold Color drop-list in the Customizing box.

• The Preview Color drop-list in the Customizing box.
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• The Wand Color drop-list in the Customizing box.

• The ROI Color drop-list in the Customizing box.

COLOR DROP LIST

The new color palette.

The first six colors and the last two colors in the palette are the same as in previous versions. The 
middle seven colors have changed.

Customizing Box Changes
The new color palette is used drop list in the Color region of the Customizing Box. 

In additon, the ROI color can now be set on the Customizing box. 
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CUSTOMIZING BOX

Customize System Settings

RESET COLOR BUTTON

If you change the colors for the items in the Color region, the new colors are 
remembered across BIOQUANT sessions. However, you can change them back to the 
default colors by clicking the Reset Color button.

CUSTOMIZING BOX: CHANGE COLOR PROCEDURE

1. From the Options menu, choose Customizing.

2. On the Customizing box, in the Color region, change to the new colors you would like to use. 

3. Click the OK button to close the Customizing box.

4. Update the Image window to see the changes.

• Threshold - in the Threshold region of the ribbon, click Refresh.

OPACITY NOTE

If the Opacity is not set to 100% on the Threshold region, the color that appears 
in the Image window will not exactly match the Threshold color chosen here 
since they will be a blend of the histology color and the threshold color.

• Preview Color - in the Measurement region of the ribbon, click Preview.

• ROI Color - do something to refresh the existing ROI, like move the Pan box or define a 
new ROI.

• Wand Color - in the Measurement region (Density Wand Type), click Define and place 
some preview circles or rectangles. 
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Pseudocolor Changes
Pseudocolor is artificial coloring that can be applied to an image (usually monochromatic) to 
dramatically illustrate density gradients within a specimen.

BIOQUANT SCREEN

Pseudocolored image.

NEW FEATURES

• The menu items have been rearranged into the order that they are used: File, Table, Sample, 
Reset, Shrink
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THE PSEUDOCOLOR BOX

The Pseudocolor Box

When using Pseudoclor, first the user chooses an available Table out of the 10 table options.

Then he/she assigns colors to the palette for that table, using one of the Sample options or by 
dragging and dropping colors onto the palette.

If the user wants to Reset an existing table, this is done last.

• The Sample palettes have changed to include the following options:

SPECTRUM

PSEUDOCOLOR BOX

The Spectrum sample palette has been selected.

Uses 16 colors plus black for 0 in rainbow order to emphasize different gray scale values in the 
image. This color scheme is ideal for samples that gradually change from light to dark.
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BLACK BODY

PSEUDOCOLOR BOX

The Black Body sample palette has been selected.

Uses 16 colors plus black for 0 from blue to red, approximating the color of an object as it is 
heated. This color scheme is best for emphasizing the difference between positive and negative 
objects in an image since negative objects will tent to be blue and positive object will be orange 
and red in strong contrast. 

DIVERGENT: RED - BLUE

PSEUDOCOLOR BOX

The Divergent: Red - Blue sample palette has been selected.

Uses 8 colors, blending from dark blue to dark red. This color scheme is good at emphasizing the 
dark objects (tinted dark red) and light objects (tinted dark blue) in an image.

SEQUENTIAL: RED

PSEUDOCOLOR BOX

The Sequential: Red sample palette has been selected.

Uses 8 shades of orange, light to dark. This color scheme emphasizes the light objects by tinting 
them red.
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QUALITATIVE: 8 COLORS

PSEUDOCOLOR BOX

The Qualitative: 8 Colors sample palette has been selected.

Uses 8 colors that are chosen to be highly contrasting with their neighbors. This color scheme 
visually isolates adjacent gray scale ranges. In terms of visual display, it has the opposite effect 
continuous schemes like Spectrum and Black Body.

QUALITATIVE: 6 COLORS

PSEUDOCOLOR BOX

The Qualitative: 6 Colors sample palette has been selected.

Uses 8 colors, white for the top 255 range, black for the bottom 0 range, and the remaining 6 
that are highly contrasting with their neighbors. This color scheme visually isolates adjacent 
gray scale ranges in the middle. In terms of visual display, it has the opposite effect from 
continuous schemes like Spectrum and Black Body. This scheme is helpful for the reduce range 
function because colors outside of the reduced range are automatically mapped to white and 
black.

• The Reset menu has expanded to include options for resettng the current table or resetting all 
tables.

Reset Current Table: Resets the current Table checked on the Table menu to gray scale.

Reset All Six Tables: Resets all the Tables on the Table menu to gray scale.

THRESHOLD REGION ENHANCEMENTS
The Threshold region has the following enhancements.
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TOPIC CONTENTS

New Auto All Button Thresholds Everything 26

Thresholding Enhancements 26

Threshold Region Redesign 27

Multi-Band Threshold Enhancements 27

New Auto All Button Thresholds Everything
The new Auto All button in the Threshold region automatically sets the Red, Green, and Blue 
threshold ranges to 0 to 255, which thresholds everything in the Image window. This is particularly 
useful if you want to measure the area of a region of interst.

THRESHOLD REGION

Auto All has set the RGB values to (255,0).

• To threshold everything in the Image window, click the Auto All button.

When the Auto All button is clicked, all three of the color channel boxes are set to (255,0).

ASSIGN NOTE

You can assign the RGB values to the Selected array so that whenever the array is chosen, 
everything is thresholded.

Thresholding Enhancements
The following enhancements have been made to thresholding with the Select and Add buttons.

1. When thresholding using Select or Add, if the user clicks and drags a box as the second point, it 
now works.

2. The threshold scroll wheel now works with the Add button in the Threshold region.

3. The threshold scroll wheel now works if the threshold was set using the Array’s comment and 
then you click Add in the Threshold region.
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Threshold Region Redesign
The Threshold region has been redesigned to make room for the Auto All button. 

THRESHOLD REGION

To make room for Auto All, the Assign button has been move to the right column.

Multi-Band Threshold Enhancements
The Multi-Band Threshold feature has improved in the following ways:

• Preview Now Refreshes the Multi-Band Theshold

When the user clicks the Prevew button in the Measurement region, the Mutli-Band Threshold 
now automatically refreshes.

• The curent Multi-Band Threshold Can Be Assigned to the Array

The current MB Threshold number can be assigned to the current Selected array. This allows 
the user to swap between arrays and have the MB Threshold number change.

You assign the current MB Threshold number to the current Selected array the same way you a 
assign traditional threshold, by click the Assign button in the Threshold region.

• Assign to Dataset Supports Multi-Band Threshold

The Multi-Band Threshold file can be assigned to the Data Set using Assign to Data Set. 
Whenever the user opens the data set in the future, the Multi-Band Threshold file will also load 
into the Multi-Band Threshold box. Also, if the data set is used as a template for another data 
set, the Mutli-Band Threshold assignment will carry forwad to the new data set.

MINOR ENHANCEMENTS
The following minor enhancements have been added to BIOQUANT OSTEO.
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TOPIC CONTENTS

Auto Surface Algorthm Improved 28

Hotkey List has Changed 28

Additive and Subtractive Mode have been removed. 28

Auto Surface Algorthm Improved
The Auto Surface algorthm has been improved to better handle C and S shapes.

Hotkey List has Changed
The Hotkey List has changed to prevent users from using hot keys that are not supported during 
certain protocols.

Additive and Subtractive Mode have been removed.
Additive and Subtractive Mode were legacy features that were introduced before BIOQUANT had the 
Calculations box to total array measurements for you. Additive and Subtractive mode were causing 
problems with some of the new measurement types, so they have been removed.

The support menus “Increase Element: Current Array” and “Increase Element: All Selected Arrays” 
have also been removed.

If you need help altering your templates  and protocols to switch from Additive and Subtractive mode 
to the Calculations Box, contact Technical Services.

IMAGING EXTENSIONS: ENHANCEMENTS
The following enhancements have been made to the BIOQUANT Imaging Exensions add-on.

TOPIC CONTENTS

Save Navigator Image with Tracings: 4 GB Support 28

Pyramid TIF Export 29

microCT Navigator Enhancements 31

SAVE NAVIGATOR IMAGE WITH TRACINGS: 4 GB SUPPORT
In the Image region, the Save Navigator Image with Tracings option on the Save Image drop list now 
supports savig up to 4 GB images with associated SVG files. 

The file format of the image has changed from BMP to TIF since BMP does not support 4GB images. 
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SVG editors like Inkscape and Illustrator may not support the 4 GB TIF file, so it may be necessary to 
edit the SVG files without the associated TIF file.

PYRAMID TIF EXPORT
Users can save up to 4 GB TIF images as Pyramid TIF images.

Pyramid TIF files are compatible with a wide range of digital pathology software applications. These 
include both desktop applications and web server applications, like IIP server. 

Pyramid TIF Export is only used to export TIF images for third party software. We do not recommend 
saving Pyramid TIF images for analysis in BIOQUANT. However, BIOQUANT can open Pyramid TIF 
images it has saved.

PROCEDURE

1. Open the TIF image that you would like to save as a Pyramid TIF.

2. In the Image window (Image File Type), from the Save Image drop list, choose Save Navigator 
TIF Image as TIF Pyramid Image.

IMAGE REGION: SAVE IMAGE OPTIONS

Choose Save Navigator TIF image as TIF Pyramid Image

3. In the BQ Save Pyramid Image box, do the following:

a. Navigate to the location you would like to save the Image.

b. In the File Name box, the name defaults to the previous name with “Pyramid” appended 
to it. Change this name, if desired.
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BQ SAVE PYRAMID IMAGE BOX

The File Name defualt is the original file name with “Pyramid” appended to it.

c. Click the Save button.

The Pyramid TIF image is saved. The original TIF image is still open in the Large Image 
Navigator.
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MICROCT NAVIGATOR ENHANCEMENTS

MICROCT NAVIGATOR - WINDOW

The MicroCT Navigator Box  - Window

The microCT Navigator has the following enhancements:

NEXT AND BACK AUTO UPDATES IMAGE WINDOW

When the user clicks the Next or Back button on the microCT Navigator, the image is automatically 
udpated in the Image window. You no longer need to click “Lock.”

NEXT, BACK, AND LOCK REFRESHES PSEUDOCOLOR

If the user has Pseudocolor ON, whenever the user clicks Lock, Next, or Back and the system updates 
the Image window, on Pseudocolor, do a “Refresh Color” to update the Pseudocolor.

SCAN: ENHANCEMENTS
The following enhancements have been made to the BIOQUANT SCAN add-on.
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TOPIC CONTENTS

Scan Multiple Slides: Set Scan Area By Edges 32

Scan Multiple Slides/Scan Well Plate: Stay Live 33

Scan Well Plate: Auto Focus Pattern 33

Removed: Auto Sequential Imaging 34

SCAN MULTIPLE SLIDES: SET SCAN AREA BY EDGES
The scan area can now be set by marking the various edges of the area to be scanned. BIOQUANT 
will compute the necessary size and shape of the scan area. Scanning multiple slides at once is not 
supported with “Set by Edges.”

In previous versions, the only way to set the scan area for a section was to mark the center of the scan 
area and then tell BIOQUANT how big of an area to scan around the center.

SCAN MULTIPLE SLIDES: SET BY EDGES

From the Set By drop list, choose “Edges”.

QUICK PROCEDURE

1. On a microscope or OSTEOIMAGER, choose the objective that will be used to scan the section.
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2. On Scan Multiple Slides Setup, in the Setup region, from the Set By drop list, choose “Edges”.

3. From the File Format drop list, choose the file type for the scan.

4. Enter the section ID under the diagram of the slide.

5. Move the stage to one edge of the area to be scanned.

6. Click the Set Edge button.

The computed scan area will appear on the slide diagram.

7. Move to other edges of the scan area and click the Set Edge button for each edge.

As more edges are set, the scan area will expand automatically.

8. Make other setup choices and then click the OK button to close Scan Multiple Slides Setup.

SCAN MULTIPLE SLIDES/SCAN WELL PLATE: STAY LIVE
If you are on a live image, when you open the Scan Multiple Slides or Scan Well Plate boxes the 
system no longer goes held.

SCAN WELL PLATE: AUTO FOCUS PATTERN
Support has been added to Scan Well Plate for the same Auto Focus methods and patterns that are 
are supported in Scan Multiple Slides.

FOCUS METHOD

• Auto: Use the Auto Focus mechanism.

• Manual: Pause periodically for a person to adjust the focus.

• None: Do not stop to check focus, just collect images.

FOCUS PATTERN

• Once Per Well

• Once / Field

• Once / 2 Fields

• Once / 3 Fields
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REMOVED: AUTO SEQUENTIAL IMAGING
Now that SCAN has been improved to support setting a scan area by its edges, Auto Sequential Image 
has become obsolete. The “Auto Sequential Imaging” and the “Test Auto Sequential” tools have been 
removed.
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